
Twips and Tricks

Twips and Tricks-
Printing and Reporting
Open the Print Template Editing.pmx file 

to work with throughout this self-paced learning

*A Twip is a unit of measurement used in the Print Template Editor.  We will cover more details during this training.  

*



VIDEOS
Every time you see the "play" icon, click to view

the accompanying video

https://youtu.be/LVqtghNLe8w


Dropdown:  Manufacturer

Code:  Blank

Company:  ProjectMatrix

Address 1:  11240 Cornell Park Dr

Address 2:  Suite 102

Address 3:  Blank

City, State Zip:  Cincinnati, OH 45242

Country:  USA

Contact:  Erin Corrill

Phone:  513-554-1665

email:  erin@projectmatrix.com

Custom:  Blank

TWIPS AND TRICKSPROJECTINFO

Users can put info that needs attached to the Project here.  

This information can be added to a print report.  

ADDRESS TAB:
Enter the below information into the sold to column



TWIPS AND TRICKS

PROJECTINFO

Select:  Blank

Name:  Your Name

Sales #:  1234

Phone#:  Your Number

Mobile #: Your Number

Email: Your email

Custom: Blank

Users can put info that needs attached to the Project here. 

 This information can be added to a print report.  

SALES INFO TAB
Enter the below information into the Sales



PO Number: 123456

Job Number: Blank

Contract Number: Blank

Account Number: Blank

Revision Number: 2

Order Type:(Edit box to the left will let you edit the

dropdown option):  Select 

Custom 1:459-145

Custom 2:

Custom 3:

Edit:Edit Checkbox will let you change the Custom 1,

Custom 2 and Custom 3 box.  Check the Edit box and

Change Custom 1 to Quote Number

PROJECTINFO
Users can put info that needs attached to the Project here. 

 This information can be added to a print report.  

ORDER INFO TAB: 
Enter the below information into the Dealer section
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PUT IT INTO PRACTICE

PROJECTINFO

PO Number:  Blank

Job Number:  Blank

Contract Number:  Blank

Account Number: 789

Authorized by:  Rob Detrick

Custom 1: 

Custom 2: 

Custom 3:

Edit: The Edit Checkbox will let you change the Custom 1,

Custom 2, and Custom 3 box.  

Users can put info that needs attached to the Project here. 

 This information can be added to a print report.  

ORDER INFO TAB

ENTER THE BELOW INFORMATION INTO THE CUSTOMER SECTION

ENTER THE BELOW INFORMATION INTO THE DATES SECTION
Order Date:  Change to Today's Date
Note:  Blank
Ship Date:  Change to 6 weeks away
Note: Blank
Install Date: Change to 7 weeks away
Note: Installer to be determined at next meeting



PUT IT INTO PRACTICEPROJECTINFO

Edit:Edit Checkbox will let you change the Saved Notes

Make the following changes

Saved Note 1:  Free Shipping

Saved Note 2:  Net 20

Saved Note 3:  Net 30

Saved Note 4: 50% Deposit

Leave the rest blank

Users can put info that needs attached to the Project here. 

 This information can be added to a print report.  

NOTES 
SAVED NOTES: THESE WILL SAVE TO THE COMPUTER TO BE USED AGAIN 

CUSTOM NOTES: WILL SAVE TO THE PROJECT 

Custom Note 1:  Delivery must happen between 9-5 at Dock

door 2.  Please call installer after delivery.  

TWIPS AND TRICKS



PROJECTINFO
USERS CAN PUT INFO THAT NEEDS ATTACHED TO THE PROJECT

HERE.  THIS INFORMATION CAN BE ADDED TO A PRINT REPORT.  

CHARGES TAB 
Additional Charges:  These will save to the specific Project.  

You will need to create new ones with each new Project.  

Make the following changes to yours.  

Tax:  These will save to  your computer to be used on future Projects.  Add a Tax 



TWIPS AND TRICKS

PUT IT INTO PRACTICE PROJECTINFO

Company:  ProjectMatrix

Address 1:  11240 Cornell Park Dr

Address 2:  Suite 102

Address 3:  Blank

City: Cincinnati

Sate:  OH

Zip:  45242

Contact:  Erin Corrill

Phone:  513-554-1665

E-mail:  www.projectmatrix.com

USERS CAN PUT INFO THAT NEEDS ATTACHED TO THE PROJECT
HERE.  THIS INFORMATION CAN BE ADDED TO A PRINT REPORT.  

DEALER CONTACT INFO
ENTER THE BELOW INFORMATION

IF YOU HAVE MULTIPLE LOCATIONS THIS INFO CAN BE
SAVED/LOADED

CLICK APPLY WHEN YOU HAVE MADE ALL THE DESIRED
CHANGES



DETAIL TAB
The Detail Tab will let you group line items by criteria and see all the
detailed information about the selected part number.  You can add
images to the grouped Tags for printing

Filter By:  Tag 1

Select Office 01

Group Description: These are the new Panels for the open seating area

Group Image resources: Browse on your computer for a .jpg or .png

Click SAVE

Continue adding Descriptions and images to the rest of the Tags

Click Print: Click Next when the Print window appears.  Select Tag 1 Full

Detail Report and click Preview.  

This will show you the possibilty of what your report can look like with

images added to it.  



Reporting Tab
The Reporting tab houses some commonly used financial, part detail, and
option reports.  These can be edited in the Print Template Editor.   

AN OCI PRESENTATION 2020

PART DETAIL REPORT OPTION REPORTFINANCIAL REPORT BY
TAG



REPORTING TAB
Reports in the reporting tab can be edited, but
first they need to be moved to a new location.  

https://youtu.be/LVqtghNLe8w


ProjectSpec5 comes with several default reports. 

 These are commonly requested by users.  

We have added our branding to them, to prompt you

to make them your own.  In the video on the next

slide, we will show you how to add in your company

logo and change the colors around to fit your graphic

standards.  

EDITING DEFAULT
REPORTS

ADD YOUR GRAPHIC
STANDARDS

PRINT TEMPLATE EDITOR



In the Reports tab, click on the piece of paper to create a new report.  
The Header section is the very first thing that will be seen when
printed.  This normally contains the Sold to: and Ship To
information.  Much of what is stored in ProjectInfo goes here. 
The Page Header Section will be the first thing seen starting on
page 2, and on EVERY PAGE after
The detail section is where your spreadsheet will print.  It will print
in the same order as the spreadsheet unless grouping is added to
the report.  This will be covered later. 
Page Footer will show at the bottom of EVERY page.  
Footer is the very last thing to be printed.  Normally contains Totals
and Terms and Conditions

TWIPS AND TRICKS

While ProjectSpec5 comes with several default reports, you

may find a need to create your own.  We will go over the steps

involved in creating your own custom report.  

CREATING YOUR OWN REPORT

https://youtu.be/6DOzJE44NSs


ADD YOUR 
COMPANY LOGO

In this video you will see how to Delete 

the ProjectSpec5 logo, add your own logo, 

and change some of the color themes

https://youtu.be/DWP0LAAF-88


Left Side TabsAN OCI PRESENTATION 2020

REPORTS
This is where all the reports in

your template are found.  

GENERAL SALES/ORDER NOTES/CHARGES
This is where basic Project Info

can be found, dealer contact

info, Sold To, Ship To, and

Address 3.  These fields can be

dragged and dropped into your

report 

This is where Sales, Design, Account

Manager info can be found.  Also, you

can find the Dealer, Customer, and

Dates information here.  These fields

can be dragged and dropped into your

report.  

Saved Notes, Custom Notes,

Addition Charges, Tax, and

Information from the Discount

Table, can be found here.  These

fields can be dragged and

dropped into  your report.  

DETAIL
Part Detail, Options, Tagging, Special,

Shipping, and Miscellaneous columns

from the spreadsheet can be found

here.  These fields can be dragged

and dropped into your report.   

PRICE GROUP TOTAL
Unit/List, Dealer/Purchase,

Customer/Sell, Margin, and Price

Zone info can be found here.  These

fields can be dragged and dropped

into your report.  

This is where the Grouping info from

the Details Tab can be found.  

Price Totals, Percentage Totals,

and Option Summaries can be

found here.  



The Property Tab allows you to finely edit fields in the Report.  You can change the Font, Colors

(using supplied colors or entering your own RGB Codes), height and width of a field, and more.  

To Edit a field, select it first in the report then go to the Property Tab. 

Height, Width, and placement can be finely manipulated using TWIPS.  TWIPS are a graphical

measurement used in Print Template Editing.  1440 TWIPS equal 1 inch.  If you want a field to

start 1 inch into your report, you can move it 1440 twips.  

Click here for a TWIPS calculator.    

PROPERTY TAB
IN-DEPTH EDITING

AN OCI PRESENTATION 2020
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WATCH THIS VIDEO ON THE PROPERTY TAB

https://projectmatrix.com/custom-templates/#Twip%20Calculator
https://youtu.be/4CiKyCiXHUE


Top TabsTWIPS AND TRICKS

FILE
New, Open, Save, Save As, Close

and all your recent Print

Templates can be found here.  

HOME DESIGN ARRANGE PAGE SETUP
New, Open, Save, Save As,

Option, Close Designer, Exit

Spec Print, and Save & Exit can

be found here.  

The Design Tab is where you can

make edits, change fonts,

Group/sort the report, add a sub

report or material swatch, add

common calculated fields,

company logos, part previews,

and Grouped Tagging Images

The Page Setup Tab will let you

preview the report, make edits

(cut, copy, paste), set report to

Portrait or Landscape view, and

change sizing and margins in

the Page Setup command.  

The Arrange Tab is where you

can make edits (Cut, Copy,

Paste), change styles, edit the

grid, align fields, position fields,

and change field sizes.  



ARRANGING FIELDS IN YOUR
REPORT

Arranging fields in your report can be tricky just using your

mouse.  Select multiple fields by using the CTRL key on your

keyboard, making a selection box, or clicking in the margin to

select everything in that row or column. The field with the

BLUE corner boxes is the anchored field.  Meaning other

selected fields will snap to this anchored field.   

ADDING FIELDS TO YOUR
REPORT

Adding fields to your report are simple.  

Click and Drag the field and place it into

place on your report. 

https://youtu.be/Nwbu5D0AEbo
https://youtu.be/F_8U5h9vPuE


Click ADD 
Group By: select Tag 1
Sort Ascending (if no sort is selected, then the report will
print in spreadsheet order, if you want a subtotal, this will
subtotal every time Tag 1 changes. )
Keep Together: First Detail (This will guarantee that you dont
end up with a Tag header at the bottom of a page without
corresponding info)
Header: Check (This will let you enter the Tag information)
Footer: Check (This will let you enter a subtotal)
Click OK 
Go to Detail Tab (on left) and Drag Tag 1 into Tag1 Header
section
Drag Tag1 into Tag1 footer
In the design tab, click on the greek letter Sigma and select
Customer_Ext.  This will be the subtotal Sell Price for that
specific tag. Draw a box in the Tag1 footer field.  
Click Preview

The reports will print the same order as the spreadsheet, and
without subtotals unless those are added to the report.  Click on
the Sorting and Grouping icon on the Design Tab.  

SORTING AND GROUPING PRINT TEMPLATE
EDITOR



SORTING GROUPING
AND SUBTOTALING. 

https://youtu.be/pLPs7n1eea4


VB SCRIPTVB SCRIPT

ADVANCED SETTINGS

To combine a "label" and a "field" you can type the

following into your field

"label" & (field)

Date formats

 Format(Now, "Short Date") 

1/1/2020

Format(Now, "Medium Date")

1-Jan-20

Format(Now, "Long Date") 

Wednesday, Januray 1, 2020

Add % to the END of a field (Be sure to remove the

formatting of currency or #.00_

FORMAT(FIELD, "#.00") & "%"

a.

b.

c.

TWIPS AND TRICKS

The print template editor will allow you to edit a LOT of fields,
make changes, and really customize your report.  However,
there are times that it is not enough.  In these cases we can do
some more advanced editing using some VB scripting.  

https://youtu.be/uQpcH3WncWI


ADD BOUND IMAGE
ADDING IMAGES FROM

THE SPREADSHEET

TWIPS AND TRICKS

PICTURE COMPLETE ICON SWATCH

You can add more images to your report besides your company logo.  

Click on the Add Bound Image Icon and select from 

https://youtu.be/jn5C0scsNMQ


SUB-REPORT

EMBED A REPORT INSIDE A REPORT
If several reports will have the same information, a sub-report can save

you lots of time.  This is often used with the same header on several

reports, or adding your Terms and Conditions to several reports.  

ON THE DESIGN TAB CLICK SUB-REPORT
Go to the report you want to add the Sub-Report too.  Click on Sub-report

on the Design tab and select the report you want to add.  Draw a box the

Width of the report.  Click Preview to see your new sub-report

https://youtu.be/CmAAEReD8BY


Styles let you make alternating lines in the

detail section a different color.  

TWIPS AND TRICKS

STYLES

https://youtu.be/Eqh0MQYz2lY


CONTACT INFORMATION

MAILING ADDRESS

11240 Cornell Park Dr.  Suite 102 Cincinnati, OH 45242

EMAIL ADDRESS

training@projectmatrix.com

PHONE NUMBER

513.554.1665

WEBSITE

www.projectmatrix.com


